ProjectTeam Help Center

- prOjeCtTeam Quick Reference Guide

Reports

Reporting is available in all project and can be accessed from the Project Homepage or from anywhere
within the project by clicking the 'Reports' button in the upper right corner of the secondary navigation
bar.

1. Click the Reports icon on the left navigation pane.

2. The reports pane will open.

Project Reperts

Reports and Dashboards

3. There are three folders contained in the reports tree.
a. My Access Only — contains reports you are currently working on and are accessible to
the User only.
b. My Company Access — Reports that are ready to use on the project and accessible to all
users for your company.
c. All Users Access — Reports which are published and ready for use by all project users.
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+ # Getting Started
E Search report names

Project Reports

@ > = My Access Only

> @ My Company Access

> & All Users Access

4. By default all users will have access to All User Reports in the System Reports folder. The
reports will be organized by the form type name. Reports contained in this folder are locked
and cannot be edited. To make changes to any System Report the report must be cloned to
either My Access Only or My Company Access Custom Reports folders.

l\ -

Project Reports
G) v My Access Only

vil@ My Company Access
> & Standard Reports
> & Custom Reports
v = All Users Access ]

v mm OySterm Reports
> & Action ltems
> & Change Orders
> @& Directives
> & Drawings
> & Payment Applications
> = Potential Change Orders
> & Project Directory
> & Requests For Information
> & Specifications
> = Submittals

> = LUSTOm Reports

5. Although any user can run any System Report, they must have access to the form data to

generate the report. If they do not have access to the data contained in the report they will only
receive a blank report.

Potential Change Orders

Lag View, it

by Cost, Sarted by PEO &

Tetal Patential Change Orders: 0

Page 1

6. To create a new report click the plus sign (+) in the top left corner of the screen.
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= +
>

Project Reports
> & My Access Only
> & My Company Access

> = AllUsers Access

7. The User will be prompted to select the Build (type) report to be created.

@ Discover

E % ExpressView

Build
@ #»  Express Report
© Advanced Report

8= Crosstab Report

Assemble
B Dashboard

@ Chained Report

a. Express Report — Quickly create tabular reports with essential operations like sorting,
filtering and calculations. Easily format and summarize data.

b. Advanced Report — Create reports containing charts, maps, gauges, and images. Add
group sections to provide more flexibility in how data is displayed.

c. Crosstab Report — Create reports that pivot data. The number of columns and rows in
the crosstab expands based on the data itself.

8. Enter the report name in the blank field.

9. Select the folder where the report is to be saved by clicking the folder title.
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Complete the steps in the wizard below to create a new report

Name Categories Sorts Filters Layout

Enter the report name

Select folder for the report

> & My Company Access

> All Users Access

10. Click the Next button to open the Categories tab.

Complete the steps in the wizard below to create a new report

Name Categories Sorts Filters Layout
Enter the report name
My new report
Select folder for the report

> = My Access Only

> = My Company Access
> = All Users Access

Enter a description for the report

Next Cancel

11. Double-click the form name where the data resides (i.e. Request for Information, Projects,
Company Logo) to add this information to the report. This will allow access to the information

contained in the RFI data form, project specific data such as company name and address and the
company logo. Click the Next button to open the Sorts tab.
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Complete the steps in the wizard below to create a new report

Name Sorts Filters Layout

Select categories 1o include on report

Search

Meetings - Invitees

Payment Applications

Category Name

Projects x
Reguests For Information

Company Logo '3

Payment Applications - Iltem Breakdown

Potential Change Orders

Potential Change Orders - Altemnates

Potential Change Orders - Cost Breakdown

Potential Change Orders - Exclusions

Potential Change Orders - Inclusions

Product Video Tutorials %

Project Directory - Businesses

Punch List ltems
QRGs

Report Templates

Requests For Proposal

Requests For Proposal - RFP Reviewers

=+ Add [i ]

Previous Next Cancel

12. Double-click the primary field to sort by and click the dropdown to choose Ascending or
Descending. Click the Next button to open the Filters tab.

Complete the steps in the wizard below to create a new report

dama  Categories Fiters Layeut

Select sort fields

ECE—

o Add o Add Formula

Sort By Sort Order
Requests For Information v o — R
Answer

Document_ID

Question

13. Filters may be applied to the field types using an operator and entering specific filter criteria.
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Complete the steps in the wizard below to create a new report

Name Categories
Select filte felds to include on report

Requests For Information v

Filter By
% Requests ForInformation Answer

Document_ID

Avox
Question
Subject
faul o B
& ada

Pramgt For Value

IREuu975 For Information. Answer = Null

Previous Next

Note: If the user will be required to enter a value, click the Prompt for Value radio button
the Next button to open the Layout tab.

[ o v C
CCE——
N
= Bl

B -~ =

14. Double-click each field, in the order the fields should show on the report.

Complete the steps in the wizard below to create a new report

Name Categories Sorts Filters Layout
Select fields to includ

eport

Requests For Information M & Requests For Information. Subject

4 Reguests ForInformstion Cuestion
& Requests For Information. Answer

Data Field

Summary Function
Document_ID

ione

e N vAavX
f Nom vAv X
f Nom
Question
Subject

v AV

Summarize By

Requests For Information
& ada @ Page Header

Page Footer [ Grand Total

My new report

Subject Question Answer
Subject 1 Question 1 Answer 1
Subject2 Quesion 2 Answer2
ubject Question 3 Answer3
Sublect 4 Question 4 Answerd

Previous

Note: To reorder the columns, use the up or down arrows, in the top right hand grid, to move

the columns to the desired location. Click the Finish button.
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Complete the steps in the wizard below to create a new report

Name Categories Sorts Filters Layout
Select fields 1 include on report
Data Field “Summary Function
Requests For Information ¥ 2 Requests For Information Subject i None v A v X
_ & Requests For Information Question |« None v A v X
& Requests For Information Answer £ None v A v X
Document_ID
Question
Subject
Summarize By
Requests For Information
o+ Agd @ Page Header Page Footer Grand Total
My new report
Subject Question \nswer
Subject 1 Question 1 Answer 1
Subject 2 Question 2 ‘Answer 2
Suent 3 Queston 3 ‘Answer 3
Sutjest £ Queston £ Answer s

15. To view the draft report, click the Run Report button.

B N Bru-as: FEaS Export POF | ¥

Section % A (Subject) B (Question) C (Answer)

My new report

Page Header 2

3 Subject Question Answer

r r. r

Regquests For
Detail 4 Requests For Requests For
et Information. Subject :_‘nfonnallon.uuestlu Information Answer

Edit and Formatting a Report
A user may only edit reports they own. To edit a report created by another user, the user will need to

first clone the report a folder.

1. Click the Reports icon on the left navigation pane.
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2. The reports pane will open.

Reports and Dashboards

Project Reports

G) My Access Only

> = My Company Access

> mm All Users Access

Click the title of the report, click the three bars icon and select Edit.

Project Reports

v & My Access Only

° oz
> & My Company Access
» & AllUsers Access
» Run Report
I+ ExportAs »
™ Schedule Report

Email Report

-

Rename

w

Clone

X Delete

4. To insert or delete a row, click the row number and select Insert Rows Before, Insert Rows
After or Delete Rows.
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#
]

e : fom o T
¥ 1B G PoF | w
Blanmer)  ClConglete) D (Requirea Doe)
* | Test Report
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5. To add the Company Logo, click inside the cell where the logo will reside and click the function

key.

g O Mynewreport Getting Started
RN o =Ez o\ zﬁ =
v = = = =
= Fields v B J U-A%S = E1F = BE Exnort PDF | w
= Formula Editor:
Fo) > Company Logo oy A(Sublect) Create formulas to perform calculations on data. pewe)
> Projects
i 1 My new report
> Requests For Information PageHeader
3 Subject Questien Answer
Detail A [f r "Requests For
etail Requests For Information.Subject  Requests For Information. Question Information Answer

6. Inthe Search for Functions field, type Loadlmage. When function displays, double-click the
function to add it to the function statement box.

Formula Editor

Loadimagd
company Logo -

Project 1D

4 add

7. Inthe field selector, double-click the Logo field to add to the function statement box and click
the OK button to save the function.

Formula Editor

Loadimage
Company Logo
e v Other
(5 ["] Loadimage
Project_ID
o Add
o+ Add

{company Lago.Logo))| I
|
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8. To add the Project Name and Project Number to the report, select a cell and enter the following
function: = {Projects.Number} & " " & {Projects.Name}

Formula Editor

Company Logo v
Logo

Project_ID

& Add

> Aggregate
> Logical

> Date

> Database and Data Type
> Arithmetic and Geometric

o+ Add

I{Projec(s.Numher) L

(Projects.Name} I

“ Gareel

9. Click your right mouse button on any section to then select Add Section such as Page Header,
Report Header, Report Footer, Page Footer, Group Header, Group Footer or Repeating Group.

o

A #*
Fields

> Company Logo
> Projects

[CRN (AN A

> Requests For Information

a. Section
i
ii.
iii.
iv.

Vi.

Vii.

viii.

etting Started

o A 3, A v = IEBE =
v BT U. A% = EI1F =
1 ={Company Logo.Logo} il
2 ={Projects Number} & " & {Projects. Name}
PageHeader 4
4
5 Subject
; r r
Detail 6 Renuesis For Information. Subject - Requests For Infermation. Q)
Footer: Reques
For
Information.Su
[F] Report Header
[= Report Footer
[ Page Footer
P Section Shading B Group Header
[=] Group Footer
[E Repeating Group

Descriptions

Page Header — appears at the top of every page.

Report Header — appears at the beginning of the report.

Detail — appears once for each row of data returned during execution.

Report Footer — Contains summaries for the entire report and appears at the
end of the report.

Page Footer — appears at the bottom of each page. Can report on things such as
Page #, etc.

Group Header —used as leading or title areas for more detailed information that
follows. A report can have multiple group headers for varying levels of data.
Group Footer - used as trailing areas for more detailed information that
preceded it. They are mainly used for aggregate data, such as sums and
averages. A report can have multiple group footers for varying levels of data.
Repeating Group - used for information that you want to repeat before
continuing with other information in the report. Each repeating section can
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have its own header and footer allowing aggregate values on just the
information within the repeating group.

10. Basic formatting can be performed on the report using the formatting section at the top of the
report. Select the cell(s) to be formatted and select the format from the toolbox below:

A & | Aral v
B I U+ A % 8

a. Format cells

b. Format print brush

@ﬁmsl -
B U. A& 8

c. Format font

P4 Cr—
B J U-.A%[s |

d. Bold

3 & | Adsl v

I U+ A% 8

e. ltalic

M3 & | Al v
B[T]u- a5
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f. Underline text

g. Textcolor

[H & | Adal v
B I gvga

h. Background color

0 & | Adal v

Scheduling Report

Reports can be scheduled to email to a select group of users or email addresses on a daily, weekly, or
monthly basis. To schedule a report follow the instructions below:

1. Click the report name for the report to be scheduled.

+ 4 Getting Started

H Search report names...

Project Reports

G} v mm My Access Only

oot =

> = My Company Access
> = All Users Access
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2. Click the 3 bar icon and select Schedule Report.

+ # Getting Started

E Search report names...

Project Reports
® v My Access Only

0 My new report E

» = My Company Access

#  Edit
> & AllUsers Access
» Run Report
|+ Export As >

IG Schedule Report I

Email Report »

= Rename
@ Clone
X Delete

3. The report schedule pane will open to the Recurrence tab

tab.

Page 13

. Complete the following fields on this

o= | G schedule Report Getting Started

Search report names. Complete the steps in the wizard below to schedule a report
Project Reports Recurrence Filters Recipients

v & My Access Only

® Schedule Name
© My new report uE
> i My Company Access a
Export Type [PDF v|  Password (optional)
> & All Users Access a

O Execute Immediately

Schedule Time
@ [ RepeatEvery..

hour(s) [ minute(s)

Schedule Time

Recurrence Pattern

® once

O paily

© Weekly  schedule on
© monthly

O Yearly

Range of Recurrence
Start ® No end date
End after |1 occurrences

My new report Description End by

Confirm Password

Previous. Cancel

a. Schedule Name.

Schedule Name

b. Export Type
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Export Type |[FDF ¥ Password (optional) Confirm Password
Excel

Execute tely

RTF
Schedule 158V

c. Check the Execute Immediately only if you want the report to email upon saving the
schedule. Enter the Scheduled Time the reports is to email and if you want it to
repeat hourly.

Execute Immediately

Schedule Time

Schedule Time L L] Repeat Every...

d. Recurrence Pattern

Recurrence Pattern

Once
Daily Recur every |1 week(s) on:
& Weekly Sunday Monday Tuesday Wednesday
Maonthly Thursday Friday Saturday
Yearly

e. Range of Recurrence

Range of Recurrence

Start ® No end date

4. Click Next.
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+
L] Complete the steps in the wizard below to schedule a report
Project Reports Filte:
o ’ o8 \“4lzr‘l"-’-1'\.l-z \I-?z::r
Y:“ e E POF ¥ P on
E nmediatel
opm @
Rect e
Range of R
t[o 19 @ No end date
5. The Filters tab will open. Any filters applied to the original report will remain. The User can also
apply additional filters if necessary. Click Next.
+
B

Complete the steps in the wizard below to schedule a r

Filier By
mpany Logo 212 Fot Information Answe

& Add

SUMMARY

6. The Recipients tab will open. Enter email addresses in the To, CC, and BCC fields and add any
text necessary to the body of the email. Click Finish.
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s | @ schedule Report Getting Started
B Q Searchreport names... Complete the steps in the wizard below to schedule a report
Project Reports Recurrence Filters Recipients
1) v = My Access Only
© My new report
[»]= Y
> & My Company Access a
> & All Users Access a Ce
Bec:
Subject: ‘Your Report: My new report
‘Attached is your report: My new report.
This report was created in ProjectTeam.com. For mare information, visit wyw.projectteam.com
My new report Description

Previous Cancel
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